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INTRODUCTION
Purpose Of This Manual

The purpose of this manual is to give detailed information on the layout, construction, configuration, and maintenance of the
Oregon State University Computer Science Lab Logger version 1.0.2. Some of the information will be specific to the
implementation in use at OSU. Most of the information is general to all implementations, with the OSU implementation
providing examples of possible ways to configure the package. With the information in this manual, an experienced

HyperCardTM user should be able to configure a basic system for a specific lab utilization, do the weekly and
quarterly maintenance tasks, and to modify and expand the basic implementation to better fit their own needs.

System Specifications

A minimum system should consist of a 1 meg. Macintosh with a hard drive. It is strongly suggested that a more
powerful (faster) system be used. At OSU, we use a 4 meg. SE/30 running MultiFinder™,

What You Should Already Know

The CS Lab Logger is a system composed of several HyperCardTNI stacks. Maintenance personnel should
already be familiar with HyperCardTM’s use of: Stacks, Backgrounds, Cards, Fields, and Buttons.

WARNING - The CS Logger makes use of a modified Home Stack. HyperCard™ expects only one
Home Stack, therefore the CS Logger will conflict with the use of regular HyperCard ™ stacks. Going to

“Home” from one of the basic HyperCardT'VI stacks (say Art Ideas) will open the CS Logger’s Home
stack, which starts up the Logger application.

Extensive use is made of the HyperTaIkTM scripting language. Maintenance personnel need to know how to
access and modify scripts and understand the hierarchical command structure of HyperTaIkTM.

If enhancements to the basic system are to be made, knowledge of how to edit Macintosh Resource files may be
necessary. Mainly this will be necessary only for modifying button icons (see Machine Icons under Configure

the Logger).

All Maintenance personnel should already be familiar with the basic operation of the Logger as outlined in the
“Lab Loggers General User’s Manual”.

Folders And Stacks

Components of the CS Logger can be found in 3 folders:

*CS Lab Logger* Super User Manual *CS Lab Logger*




Table of Contents

Lab Logger
Data
Manual.
C5 Logger
Manual Lab Logger Crata
| | I | | | |
FManual-“ord Super User Man. Archive Labllze Fields Support  Databasze

OO 0

LabUze text Macllse text cico text Seripts lcons

PO P &P @

LS Logger Horne Latabaze Uzage Motes Schedules Talw

¥ ¥ &

Farl l=a | akl lse rinn

The Lab Logger folder contains the CS Logger application (HyperCardTM) and most of the stacks. This is the
critical information that should be backed up weekly (see Weekly Tasks). In addition to the application, this folder
contains :

Home Stack containing the look up paths, access to utilities, and global scripts and resources.
Database A database of lab user information.

Logger Stack containing the Lab card, the individual machine cards, and the Configure card.
ToDo A calender of upcoming events.
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Schedules A database of Lab Consultants, Lab Assistants, Teaching Assistants, and the hours they
are scheduled to work.

Notes A database of questions commonly asked consultants, and their answers. Also details of
lab procedures and policies.

Usage Folder Contains lab use statistics stacks.
LabUse Statistics on machine use in the lab by type.
MacUse Further breaks down use statistics on Macintosh'’s.

cico Alist of who logged into what machine at what time.

The Data folder contains support information and the Archive.
Archive Stack containing the last terms user information.
Database folder Receptacle of reports generated on the user database.
LabUse folder  Receptacle of reports generated on lab use statistics.
Fields folder Receptacle for dumps of card fields
Support folder  Contains support materials.
Scripts Receptacle of reports listing contents of scripts.

Icons Contains the button icons installed in the home stack and tools to edit them.

The Manual folder contains the CS Logger manuals
Manual-Word General user manual in MS Word format.

Super User Man. This Manual in MS Word 4.0 format.

Logging In As Super User

HyperCard™ lets the user select between five different levels of permission.

1 Browsing Clicking on buttons and limited menu items.

2 Typing Browsing, plus entering text in fields.

3 Painting Typing, plus drawing on cards and backgrounds. Expanded menu items,

4 Authoring Painting, plus the ability to create buttons, fields, cards, and stacks. Expanded menu
items.

5 Scripting Authoring, plus the ability to make and edit HyperTalk™ scripts.

Normally, the Logger operates at the Typing level. This is sufficient for the daily operation of tasks. There are
numerous tasks and operations that only need to be performed for system maintenance. These operations are
disabled and hidden during normal operation.

The standard HyperCardTM data protection scheme involves password protecting each stack to restrict access. As
the Logger contains multiple stacks, the normal protection scheme would entail multiple password entry while a
maintenance
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person flipped between stacks. It also makes the security wise practice of the periodic changing of passwords
difficult, therefore it is less likely to be performed.

The standard HyperCardTM password protection scheme is not used in the Logger. Instead, supplying one
password allows access to all levels of all stacks. Each maintainer is given their own password, and a log is
automatically generated of who logged in when. The stock password for distribution is “secret”. It is suggested
that this is changed immediately (see below).
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To get to the Scripting level, first you need to get to the password prompt. To do this, pull up the message
window by typing a “3m”. Entering “su 5” and hitting return will produce the password prompt window. Entering
the password and hitting return should elevate the Logger to scripting level. The user can move to any level by
giving the appropriate level as a parameter to “su” (i.e. “su 2" for typing, “su 4” for authoring), but levels 2 and 5
are the most useful.

An alternate method for reaching the scripting level is to hold down the command key (36) and selecting “Protect
Stack...” under the File menu. This will take you to the “User Preferences” card of the Home stack. Select the
desired level by clicking on the appropriate radio button. This will produce the password prompt window as before.
Enter the password and away you go.

Each time a super user enters his or her password, the date, time and users name is recorded in the Super User
Log. This is a scrolling field on the
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“User Preferences” card of the Home stack. This field is only visible when above the Typing level.
Changing Passwords

To add or delete passwords in the Lab Logger, it is necessary to modify the script of the Home stack. The
encrypted password is stored as an integer in the “Check password” function of the Home stack script.

The first step in adding or modifying a password is to transform the proposed password into the encrypted integer.
To do this, open the message window (¥#m) and type the command “getPassword”. This opens a window
prompting for the password. Enter the proposed password and hit return. The message window will now contain
the integer which is the encrypted transformation of the password (see figure). This integer needs to be copied
down. The Note Pad desk accessory is handy for this.

The encrypted integer for that password is 3932163314

To add the integer, you need to be at the Scripting (su 5) level and in the Home stack (3h). There are two ways
to get to the Home stack script. One is by holding down the command and option keys while hitting the “s” key. the
other is by choosing “Stack Info...” under the Objects menu, and clicking on the “Script...” button. Once in the
script, you need to find the “Check password” function. This can be done by using the Find button of the script
editor. Alterantly, as the function is at the end of the script, you can just scroll to the bottom of the script.

To add a new password, you have to add a line of the form:
“else if password is <integer> then put "<name>" into name”

where <integer> is the integer returned by the “getPassword” function and <name> is the individuals name. The easiest
method is to copy one of the existing lines and substitute the new integer and name for the old ones. Changing an existing
persons password means changing just the integer.

To disable an old password, just delete the line. It is a good idea to test the new password before deleting the old password. If
you might want to re-enable a password at some later date, you can comment out the line by inserting two dashes in front of it
(i.e. -- else if password ...).

WEEKLY TASKS

There are three maintenance tasks that should be preformed at least once a week. These tasks are:

Printing the weekly machine usage graphs
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Entering new user data and sorting the Database

Make a backup copy of the Logger.
Printing Usage Graphs

It is necessary to be at the “su 3” level or higher in order to access and print the usage graphs. At this level, two
extra buttons appear in the LabUse stack. These are:

[
Generate a text report of times, machines, and percents

Report All

@ Select the days to graph or report on.
Salert

The first step in printing the graphs is sorting the stack. Click the sort button.

The next step is to select the days to graph. Click on the select button. This takes you to a card with a list of the
days to select from.

% File Edit Go Tools Objects 146 50T

Select from this menu. Selected Dates:
Fri, Feb 16, 1990 il Sunm, Feb 25, 1990

Sat, Feb 17, 1990
Ef%% Fri, Feb 23, 19490

o Sat, Feb 24, 1990
Sun, E@E 25, 1940
on, FEJ 26, 1990

Tue, Feb 27, 1990
Wed, Feb 28, 1990
Thu, Mar 1, 1990
Fri, Mar 2, 1990

Sat, Mar 3, 1990 One ‘week:

Sun, Mar 4, 1990 Sun, Feb 25, 1990

Mon, Mar 5, 1990 Mon, Feb 26, 1990

Tue, Mar 6, 1990 Tue, Feb 27, 1990

Wed, Mar 7, 1990 Hed, Feb 26, 1990

Thu, Mar &, 1990 Thu, Mar 1, 1990

Fri, Mar 9, 1990 :] Fri, Mar 2, 1990 <:£]
led, Mar 14, 1990 | |Sat, Mar 3, 1990
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The “Select from this menu” field contains a list of all the dates from which to choose. To select seven days worth
of dates, click on the first date in the range (for instance: Sun, Feb 25, 1990). This will fill the “One Week:” field
with a weeks worth of days (see above). If a different range of dates is required, click on the first day of the range
and drag down to the last day. This will fill the “Selected Dates:” field with the dates requested. At this point, it is
possible to either graph or generate a text report of the selected dates.

To generate a report, click on the “Report” button. A window will ask if you want the dates in the selected dates
field or the one week field. It will then generate a file in the “LabUse text” folder. The name of the file will include
the first and last days of the range.

To graph the percent of machines in use for the selected days, click and hold on the “Graph” button. A pop-up
menu will appear with all the choices available.

Dates Allows the choice between the Selected Dates field and the One Week field
Options Allows the choice of printing the graphs one day per page or a condensed graph of an

entire week on one page.

Machines Selects the machines to generate graphs for. “All” will graph all of the machines.
Selected Dates Dates '
Options | «One Week v[Day by Day
Machines » Machines P Entire Week
Dates »
Options »
All
Mac
Term
Utek
IBM
Mext

Making a “Machines” selection starts the graphing process. Once the graphs are generated, a window asks if you
are ready to print the graphs. Clicking on “OK” will bring up the “Page Setup...” and “Print Stack...” windows. It is
suggested that the “Graphics Smoothing?” option is used if printing on a LaserWriter. Clicking on “OK” will send
the graphs to the printer. After printing, a window will appear asking if you want to delete the graphs. If you wish to
generate both day by day graphs and weekly graphs:

1 Generate one set of graphs

2 Click on “Cancel” when asked to print
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Click on “Cancel” when asked to delete
4 Generate the next set of graphs
Print the graphs as usual

If you wish to print some already existing graphs, the print and delete prompts can be called up by entering

“Printall” in the message window. This can be handy if you forgot to select the appropriate printer before starting
the graph generation process.

The Database

There are two major tasks that should be preformed weekly. These are entering new user data, and sorting the

stack. There is also one minor task that can be preformed on an irregular basis. This is checking the Database for
duplicate entries.

New user data is entered by clicking on the “Add Card” button, then typing in the data. More detailed information
can be found in the General Users Manual or in the Stack Management section under Database.
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Sorting the Database can be done by clicking on the sort button and answering if you want it sorted by the users
name or user ID. Standard practice is to sort the Database by name.
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Clicking on the “Check” button will check for duplicate entries in the Database. A report of duplicates will be
placed in a file called “duplicates” in the “Database” folder inside the “Data” folder. A listing of duplicates is also
placed in the “Comments:” field of the “Temporary User Card”. As this is a moderately lengthy process and non
critical, it is sufficient to do this on an irregular basis.

Making Backups

It is wise to backup the Logger at least once a week. At the beginning of the term, when a lot of new user data is
being entered, backing up more often could save a lot of retyping if something unpleasant happened.

The first step is to compact all the stacks. Clicking on the button in the top right hand corner of the “Home Card”
will reduce the size of the stacks to a minimum.

At OSU, we use the shareware archiver “Stufflt” to make a backup copy that fits on two 800K floppy disks. To get
to Stufflt, click on the button on the Home Card that is visible when above user level 2.

Once Stufflt has been launched, open a new archive by choosing the “New Archive...” item under the File menu. It
is good practice to label the archive with the date (i.e. Logger 3/14/90.sit).

% File Edit Report Other Options 1.-19.-55‘?3@% 1
[ECI=——= Logger 3/14/90.5it —D0u—=—

File Mame Tupe Cred Size BSaved :
Lab Logger: 22303756 57E o . '
Data: 700216 578 [l ot Logger HD

Logger Restart

]

2 item=s, 1285k archiwve, 2959k decompressed.

BN [T FE Nl = N i

Add FMulkiple E:-:I:ra.-:tl Dalake Raname Info Comn... Trash
Logger HO: 16390k free.
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The best compression ratios are obtained using the Lempel-Ziv (LZW) method. This is selectable under the
Options menu.

To add the Logger folders to the archive, click on the “Multiple” button. Select the Logger folders one at a time,
and Add them to the archive list. Once all the folders have been added, click on Done. Clicking on Archive will
build an archive from the list of selected files.

Even compressed, the archives tend to be larger than 800K. In order to fit the archive on 800K disks, use the
Segment... operation under the Other menu. This will split the archive up into segments small enough that they
can be copied on to floppy disks.

Restoring from archives means reversing the process. Start with Join... under the Other menu to join the
segments of the archive together. Open the archive, then highlight the folders to be restored by clicking and
dragging over them. Clicking on the "Extract” button and on the Save button in the resulting dialog will finish the
process.

The most critical data is in the Lab Logger folder. The information in the Data folder is less critical and less
subject to change. If disk space is an issue, and a complete backup exists from the beginning of the term, then it
is safe to backup only the contents of the Lab Logger folder on a weekly basis.

QUARTERLY TASKS
Quarterly Cleaning And Reconfiguring

Archive Generation
Database Generation
Calender Generation
LabUse Stack Generation
MacUse Generation

Cico Generation
Schedules

Consultants List

SU Log
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Quarterly Backup
Backup Copy Storage
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Logger Stack Layout
“CS Lab” Card Background
STACK MANAGEMENT

Home Stack

“Look for ...” cards
Stacks
Applications
Documents

Passwords

Super User Log

Resources

Logger Stack

CS Lab Card
Configure button
SU 2 button
Hidden Buttons

“Gone” Machine Buttons
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Machine Configuration Buttons
Configure Card
Generate Next Term
Fields
Machine
Count
Total
Max

Machine Configuration Cards
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Changing Disk/Manual Lists
Machine Cards
Information Fields
Changing Mac Machine Types
Bringing “Gone” machines back to life
Finding The Machine
Returning To The Living
Moving The Machine Icon
Database
Temporary User Card
Importance of
New Card Duplication
Reference Count
Title Look Up
Fields
Background “Titles”
Foreground “Titles”
Comment
Sorting
By Name
By Student Number
Merging Databases
List Generation
Users Report
Doorstop Report
Adding New Users To The Database

Recovery Of Records From Archive
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Update This Terms Information
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Phone Number
Title
Checking The Database
Duplicate Names
Duplicate Student Numbers
Deleting Faulty Records
Marking Special Status
Invalid User
Special Notice Comment
LabUse/MacUse
Quarterly Statistics Recording
Printing Usage Graphs
Sorting The Stack
Selecting The Days To Graph
Selected days
Entire week
Selecting The Type Of Graph
Day by day
Weekly
Selecting the Machines to Graph
Printing The Graphs
Deleting Old Graphs

Archive
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Quarterly Cycling Of Archive
Generating The Archive
Compact The Archive Before Locking
Locking The Archive
Unlocking The Archive
Todo
Generating The Next Terms Cards

Logger Restart

MACHINE MANAGMENT
Basic System Software
MultiFinder
Telnet

Print Monitor
Stufflt
ResEdit
Backups
Backup Schedule
Backup Copy Storage
Automatic Start Up Of The Logger
Select Logger Restart Stack
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Select “Set Startup...” From Special Menu

Select “Selected Items” and OK
Screen Saver

Autoldle
Virus Protection

GateKeeper
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Disinfectant
Hiding The Logger Folder
CONFIGURING THE LOGGER
Configuration Card

System buttons
Generate Next Term
[]

Fields
Machine
Count
Total
Max

Configuration settings
Do LabUse?
Machine Killable?
Show Gone?
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lcon In Button?

Machine Moveable?
L/O @ close?
Adding New Machines
Making A Machine Configure Card
Changing Disk/Manual Lists
Making New Machines Cards
Information Fields
Changing Mac Machine Types
Machine Icons
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Making New Machine Icons

IconManager
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